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END-USER LICENSE AGREEMENT AND SOFTWARE PRODUCT LIC ENSE  
IMPORTANT-READ CAREFULLY : This Software License Agreement ("SLA") is a legal agreement between you (either an 
individual or a single entity) and  Business Solutions (Europe) Limited for the  software product ‘QuickScript‘ which includes 
computer software and associated media and printed materials, and may include "online" or electronic documentation ("SOFTWARE 
PRODUCT" or "SOFTWARE"). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the 
terms of this SLA. If you do not agree to the terms of this SLA, promptly return the unused SOFTWARE PRODUCT to the place from 
which you obtained it for a full refund. 

SOFTWARE PRODUCT LICENSE 

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property 
laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 

1. GRANT OF LICENSE 
 
This SLA grants you the following rights: 

Systems Software - You may install and use one copy of the SOFTWARE PRODUCT on a single computer at a time and 
only by one user at a time. 

Storage/Network Use - You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such as a 
network server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal network; 
however, you must acquire and dedicate a license for each separate computer on which the SOFTWARE PRODUCT is 
installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be used concurrently on 
different computers. 

License Pack - If you have acquired this SLA in a Multi-User License Pack, you may make the number of additional copies 
of the computer software portion of the SOFTWARE PRODUCT authorized on the printed copy of this SLA, and you may 
use each copy in the manner specified above. 

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 

Limitations on Reverse Engineering, Decompilation, and Disassembly - You may not reverse engineer, decompile, or 
disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by 
applicable law not withstanding this limitation. 

Separation of Components - The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be 
separated for use on more than one computer. 

 Rental - You may not rent or lease the SOFTWARE PRODUCT. 

Software Transfer - You may permanently transfer all of your rights under this SLA, provided you retain no copies, you 
transfer all of the SOFTWARE PRODUCT (including all component parts, the media and printed materials, any upgrades 
and this SLA), and the recipient agrees to the terms of this SLA. If the SOFTWARE PRODUCT is an upgrade, any transfer 
must include all prior versions of the SOFTWARE PRODUCT. 

Termination - Without prejudice to any other rights, may terminate this SLA if you fail to comply with the terms and 
conditions of this SLA. In such event, you must destroy all copies of the SOFTWARE PRODUCT and all of its component 
parts. 

3. UPGRADES 

If the SOFTWARE PRODUCT is an upgrade from another product, whether from or another supplier, you may use or 
transfer the SOFTWARE PRODUCT only in conjunction with that upgraded product, unless you destroy the upgraded 
product. If the SOFTWARE PRODUCT is an upgrade of a product, you now may use that upgraded product only in 
accordance with this SLA. If the SOFTWARE PRODUCT is an upgrade of a component of a package of software 
programs that you licensed as a single product, the SOFTWARE PRODUCT may be used and transferred only as part of 
that single product package and may not be separated for use on more than one computer. 

4. COPYRIGHT 

All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, 
animations, video, audio, music, text, and "applets," incorporated into the SOFTWARE PRODUCT), the accompanying 
printed materials, and any copies of the SOFTWARE PRODUCT, are owned by  or its suppliers. The SOFTWARE 
PRODUCT is protected by copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE 
PRODUCT like any other copyrighted material except that you may either (a) make one copy of the SOFTWARE 
PRODUCT solely for backup or archival purposes, or (b) install the SOFTWARE PRODUCT on a single computer 
provided you keep the original solely for backup or archival purposes. You may not copy the printed materials 
accompanying the SOFTWARE PRODUCT. 

5. DUAL-MEDIA SOFTWARE 

You may receive the SOFTWARE PRODUCT in more than one medium. Regardless of the type or size of medium you 
receive, you may use only one medium that is appropriate for your single computer. You may not use or install the other 
medium on another computer. You may not loan, rent, lease, or otherwise transfer the other medium to another user, 
except as part of the permanent transfer (as provided above) of the SOFTWARE PRODUCT. 
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LIMITED WARRANTY 

Business Solutions (Europe) Ltd.  warrants that (a) the SOFTWARE PRODUCT will perform substantially in accordance with the 
accompanying written materials for a period of ninety (90) days from the date of receipt, and (b) any hardware accompanying the 
SOFTWARE PRODUCT will be free from defects in materials and workmanship under normal use and service for a period of one (1) 
year from the date of receipt. Some states and jurisdictions do not allow limitations on duration of an implied warranty, so the above 
limitation may not apply to you. To the extent allowed by applicable law, implied warranties on the SOFTWARE PRODUCT and 
hardware, if any, are limited to ninety (90) days and one year, respectively. 

CUSTOMER REMEDIES 

Business Solutions (Europe) Ltd.’s and its suppliers' entire liability and your exclusive remedy shall be, at Business Solutions 
(Europe) Ltd.'s option, either (a) return of the price paid, or (b) repair or replacement of the SOFTWARE PRODUCT or hardware that 
does not meet the Limited Warranty and which is returned to  with a copy of your receipt. This Limited Warranty is void if failure of 
the SOFTWARE PRODUCT or hardware has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE 
PRODUCT or hardware will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. 
Outside the United States, neither these remedies nor any product support services offered by Business Solutions (Europe) Ltd. are 
available without proof of purchase from an authorized international source. 

NO OTHER WARRANTIES 

To the maximum extent permitted by applicable law, Business Solutions (Europe) Ltd and it’s suppliers disclaim all other warrantees, 
either express or implied, including, but not limited to, implied warrantees of merchantability and fitness for a particular purpose, with 
regard to the software product, and any accompanying hardware. This limited warranty gives you specific legal rights. You may have 
others, which vary from state/jurisdiction to state/jurisdiction. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES 

To the maximum extent permitted by applicable law, in no event shall Business Solutions (Europe) Ltd. or it’s suppliers be liable for 
any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of business 
profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use the 
software product, even if has been advised of the possibility of such damages. Because some states and jurisdictions do not allow 
the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you. 

 

Copyright © 2007, 2008 Business Solutions (Europe) Ltd. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Microsoft ®, WINDOWS®, NT®, XP®, Excel® and Outlook® are registered trademarks of Microsoft Corporation. 

SAP®, R/2®, R/3®, ABAP®, are registered trademarks of SAP AG 
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Welcome to QuickScript!  

QuickScript is a fast an efficient tool for creating and running automatic ‘Test 
Scripts’, for use with SAP and Microsoft Excel. It can also be used for any of your 
SAP transaction automation needs, in addition to its primary role of automating 
regression testing of end-to-end processes. 

QuickScript loads as an Add-In to Excel and requires no additional skills to use - if 
you can run an SAP transaction and add data into Excel, you can use QuickScript! 

Despite its simplicity to use QuickScript is an extremely powerful tool. 

It can record any SAP transaction (including custom developed transactions and 
complex transactions using tree controls etc.) and sequences of transactions . 

The data input by the user, when running the transaction, is captured and entered 
into Excel. 

QuickScript’s data Wizard can then be used to allocate the outputs of transactions 
as inputs to other transactions. 

Users then simply add more data records to the spreadsheet and 'Run' the script.  
 
The recorded transactions are then re-run, using the data in the spreadsheet as 
inputs - and not just once! The spreadsheet 'holds' the script and data within it and 
can be re-opened at any time, more data records added (if you require) and re-run 
as often as you like!  

QuickScript records the status of all transactions run in the script, compares them to 
the expected values and indicates pass or fail for each row of the spreadsheet. 

Very quick, very simple, very powerful! 

Remember, QuickScript is not limited to recording and running just a single 
transaction - it can also record and replay sequences  of transactions . This 
makes QuickScript ideal for all kinds of uses beyond that of a testing tool – such as 
preparing data for training systems, as many times as you like. 
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Typical Users 
QuickScript's ease of use does not mean it should be ignored by back-office SAP 
support staff or seasoned SAP consultants. In fact, this is probably the audience with 
the most to benefit – especially for automating system testing and regression testing. 

SAP project teams can also benefit immeasurably by using QuickScript, and not just 
for system testing. It's great for creating master and transaction data for training and 
could even be used for repetitive customising! It’s also ideal for unit testing of 
programs, user exits or even configuration – for example, perform a Goods Issue of 
every material type from every storage location and warehouse.   

The ease of use of QuickScript also means that it can be used by SAP end-users, 
after go-live, to record and re-play any SAP transaction. Sample uses are to speed-
up data entry of transaction data or to automate the running of a sequence of 
transactions or reports. 

Basically, any transaction that you need to run more than once is a candidate for 
capturing with QuickScript. 

It's fast, it's simple, it works! 
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Quick Install Guide 

Installing QuickScript is usually very simple but, because of the nature of SAP, it can 
sometimes require some additional SAP set-up. Full details are given in the section 
'Installation Guide' but, usually, the information below is sufficient to get up and 
running with QuickScript. 

Installation and System Requirements 
Firstly, you MUST have a version of Excel that is from Microsoft Office 2000 or 
above. Earlier versions of Excel use a different Add-In mechanism that is not  
compatible with QuickScript. 

Once you're happy that you have a suitable version of Excel, run the install program 
to install QuickScript as an Add-In to Excel. It is recommended that you follow the 
prompt to re-start your computer. 

Installing In Excel 

After completing the QuickScript installation, you should run Excel to verify that 
QuickScript has installed correctly. On starting Excel you will probably receive a pop-
up similar to the following: 
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The next action depends upon whether you the above pop-up appears. If it does 
appear, then proceed as follows: 

·  Click the ‘Details’ button. Verify that there is a digital signature from Business 
Solutions (Europe) Ltd.. Click ‘OK’ to return to the previous screen, as shown 
above. 

·  Click the check-box: 
 

 

·  Click the button . 

·  The QuickScript toolbar should now be visible in Excel:  
 

 
 
 

If you did not see the above pop-up window, it is most likely due to your Macro 
Security settings. 

·  Choose Tools > Options from the Excel menu, and click the ‘Security’ tab on 
pop-up. 
 

 

·  Click the ‘Macro Security…’ button, as show above. 

·  It is recommended that you have your macro security level set to ‘High’ or 
‘Medium’. If you have it set at ‘Low’ you may be vulnerable to unfriendly 
macros and Add-Ins. 
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·  If ‘Low’ is set, QuickScript will have installed without the pop-up and will still 
run correctly.  

·  If ‘Very High’ is set (available from Office 2003), you will need to change this 
to ‘High’. 

If you have any difficulties, please contact support. 

 

Checking The SAP Environment 

You must also be running SAP GUI version 6.20 or above. To establish your SAP 
GUI version, run the SAP Logon Pad and choose 'About SAP Logon Pad' from the 
menu - as shown below. 

 

You'll also have to make/check some settings in your SAP environment. The first is 
to ensure that scripting is enabled. 

·  Log on to your SAP system; 

·  Click the Customizing of local layout  SAP toolbar button and then choose 
Options.   
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·  Click the Scripting tab. Your settings should be made as below. 
 

 

 

·  You’ll also need to ensure that your connection speed is not set to ‘Low’. To 
do this: 

·  Open SAP Logon and select a server 

·  Click the ‘Properties’ button.  

·  Click the Advanced button. The Advanced Options dialog box opens. 

·  In the Connection speed section, confirm that the Low speed connection has 
not been selected, as below: 
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·  Newer versions of SAP have a selection for high speed connection, as 
below: 
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A common SAP setting that prevents QuickScript from running is scripting being 
disabled on the server. You may need to get your BASIS team to make this setting. 
To check if scripting is disabled, run transaction RZ11 and check the value of 
parameter sapgui/user_scripting - the 'Current value' field needs to be TRUE, as 
shown below. 

 

NOTE: If you change this value, you will need to logoff and logon again for the 
change to take effect. 

If you're still having problems getting QuickScript to work please see the 'Installation 
Guide' section where full details are given on how to make the necessary settings in 
SAP. 
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Purchasing/Registering 
The unlicensed version of this product is fully functional but limited to 30 days. Also, 
'playback' is limited to 3 data records from the spreadsheet.  

To purchase this product please contact your local distributor or email 
sales@businesssolutions.eu.com. 

You will need to provide your Product ID and program Version. These can be found 
on the Registration screen by following the steps to register on the pop-up reminder 
that appears when making a recording. 

 
 

If you have been provided with a specific license key, you should enter it on this 
screen and register by clicking the ‘OK’ button. 

Your company may have purchased multiple licenses, in which case, to simplify 
upgrades and to assist with product administration, you may not have been provided 
with a license key directly. Instead, your system administrator can be provided with a 
file containing all of the licenses purchased by your company (note that these 
licenses are still specific to the individual product installations, as indicated by the 
Product ID). If this is the case, then you should click the ‘Choose License File’ button 
and choose the licence file provided – your system administrator will need to tell you 
the location of this file (usually a shared folder on a network drive). 
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Quick Start Guide 

This Quick Start Guide is included to get you using QuickScript as quickly as 
possibly. The intuitive nature of QuickScript means that you are unlikely to require 
any further 'training'. 

This example describes the recording of the Block Vendor transaction (MK05) but 
you can use any transaction you like. In any case, before starting your recording, be 
sure that: 

·  you have access to an SAP system; 

·  that you can alter data without impact; 

·  that you have the data necessary to run the transaction (in the case of this 
example you would need several vendor numbers). 

Initially, while learning, it is suggested that you limit your recordings to a single 
transaction - many transactions can be recorded in sequence but it is easier to learn 
the basics using just one. 

Online demonstrations are also available and it is recommended that you view these 
before using QuickScript. 

Making a Recording 
Once you have the data you need follow the steps below: 
 

 

It is important to note that only fields that you type into will be 
recorded. If a field value is defaulted by SAP it will not be 
recorded. To record a field that has been defaulted simply copy it 
(select and ctrl-c) and paste it (ctrl-v) back into the field. 

 

1. Run the SAP Logon Pad and logon to your SAP system. 

2. Run Excel. 

3. Click the ‘QuickScript Record’ button, . 
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If you have not registered a reminder screen will pop-up, click ‘Continue 
Unregistered’ to continue. 
 

4. The QuickScript controls will then appear. Choose an SAP session to 
record, as below. 
 

  
 
The description displayed in the session drop-down should be familiar to 
you as it is the same that you will see at the bottom of your SAP window: 
 

 
 
If you have no open SAP sessions then the session list will be empty and a 
message asking you to start an SAP session will be displayed.  
 
You will also receive a message if your SAP Logon Pad is not running. 

5. When you have chosen you SAP session click the record button, . 
 
Your chosen SAP session window will be brought to the front, ready for you 
to record the transaction. 
 

 

It is recommended that you always run a transaction by using the 
command bar, and with the ‘/n’ prefix, e.g. enter /nmk05.  
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This will ALWAYS run the transaction, regardless of the current 
activity on the session. Consequently, the recording is less 
sensitive during playback to what you were doing previously on 
the session. 

 

6. The example screen-shots show the sequence of recording the MK05 
transaction. 

·  On the initial screen, enter a vendor number (this will be specific to our 
own system, the vendor number used below is unlikely to be on your 
system). If a vendor number was defaulted, either over-type or ‘cut’ it 
and ‘paste’ it back. QuickScript only records data you enter – nothing 
else on the screen. 
 

 

 

 

QuickScript only records the fields you type into!  Fields that 
are left blank, or are defaulted by SAP, will not be recorded. 

This is VERY important and crucial to your understa nding 
and use of QuickScript . 

If you wish to record fields defaulted by SAP either over-type the 
data already there or cut-and-paste it back into the same field. 

 

·  On the next screen, make the settings for blocking the vendor, as 
below: 
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·  Then click the save button, . 
 

·  A message similar to the following will be displayed in the status bar: 
 

 
 

7. Click the stop button, . 

8. You will then be returned to Excel, and will see a screen similar to that 
shown below. 
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That's it. You've made your first QuickScript recording! 

You’ll see that all of the data you entered is captured and arranged as columns in 
the spreadsheet. You’ll also see that the value recorded for a  is ‘true’ – an empty 
checkbox would be ‘false’. 

The columns are arranged in 'groups', one group for each transaction code. The 
transaction code is shown above the first column of data used in that transaction (it 
indicates where the transaction started). This grouping uses standard Excel data 
grouping. Clicking the , in the top-left corner of the spreadsheet, will compress ALL 
the columns into their transaction groups - showing only the transaction start 
columns, as below: 
 

 
 

Clicking  will expand the view to show all of the data for an individual transaction.  
 

 
 

Clicking the  will compress/group the data again. 

Clicking the  will fully expand the view to show all of the data columns. 

Notice that the status bar texts, along with the status message ids, have also been 
captured. An additional column ‘Expected_Msg’ has also been added – this is used 
during the run of the script for comparison against the ‘Actual’ outcome of the run 
transaction. The ‘Expected_Msg’ is set to the same value as the Actual_Msg 
captured during the original recording, but can be changed if you require. 
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You will probably have also noticed that the first row, showing the transaction codes, 
begins with "!*" (without the quotes). This indicates the beginning of a comment row. 
See ‘Adding Comments’ later. 

 

 

Column headings do not always get obvious descriptive texts. 
This is because the text used in the columns headings is 
obtained directly from SAP and, in SAP, not all of the fields are 
described properly - this is an SAP problem not a QuickScript 
problem. 

There is an example of this shown later. 

 

 

Entering Data 
Entering data for your playbacks is simple. The spreadsheet now has a column for 
every field you entered. It is vitally  important  that you do not delete any of these 
columns or re-arrange them (you can, of course, alter the width, font, etc. but the 
column position must not be altered).  

There is also one row of data, the data that was captured during your recording.  
 
Note that the check-boxes (tick-boxes) values are shown as TRUE or FALSE 
depending on whether the box was checked/ticked (TRUE) or empty (FALSE). 

In the first instance it is advisable, initially, to leave this first row of data as it is so 
that you can copy it for your additional rows. 

 

 

During playback QuickScript will stop when it reaches a blank cell 
in column A. Therefore, you can add a blank row above the 
originally recorded data and it will not be included in any 
playbacks - just be sure to start your new data rows at row 2, 
directly beneath the header row. 

 

The screen shot below shows the spreadsheet with some data rows added. 

 

Now that you have your data you can save the spreadsheet, run the recording later 
or run it now.  When run, the above recording will block vendors 70001 and 70002 
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and then stop (the entry for vendor 70000 will not be processed again because of 
the empty row above it), 

Note also that it is not necessary to delete the contents of the Status_Bar and 
Actual_Msg columns as these will be automatically reset prior to a run of the script. 

 

 

 
You can keep all of your spreadsheets and re-use them as often 
as you like. As the script is embedded in the spreadsheet all you 
need to do is change your data (as necessary) and then run the 
playback.  

 

Adding Comments 

Any number of comment lines/row can be added to the spreadsheet in any position. 
These comment lines can be used to, for example, hold the name of the person that 
made the recording along with a description of the recording. You will have seen that 
a comment line is automatically added to show the transaction codes. A comment 
row must be started by the characters !* (i.e. the first 2 characters of the row, in 
column A, must be !*). When a recording is run, comment rows are ignored. 

Comment rows can be inserted at any row, as shown in the example below. 
 

 
 

Comments can not be added to individual cells in this way - the entire row is treated 
as a comment. To add comments to individual cells simply use Excel's "Insert 
Comment" function, by right-clicking the cell and choosing "Insert Comment". 

  

Running a Recording (Playback) 
If you don't already have your spreadsheet open, open it now. Also check that you 
have logged on to the SAP system in which you wish to ‘Run’ the recording. If not, 
don’t worry, you will have the opportunity to do so later. 

1. Click the 'QuickScript Run' button, . 
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2. If you have not registered a reminder screen will pop-up, click 'Continue 
Unregistered' to continue. 

3. The QuickScript controls will then appear. Choose an SAP session to use (as 
before). 

4. When you have chosen you SAP session you can, if required, set a sleep (or 
pause) time between transactions. This is particularly useful if there is some 
latency in your network or your SAP system. 
 

 

SAP is not a true online system in that, for example, when you 
save a purchase order, the purchase order is not created 
instantly when the transaction has completed – the PO number is 
pre-allocated and SAP tells you in the status bar that the PO has 
been saved. It has not! It has actually been submitted for a batch 
input save/update. 
 
If you have a particularly slow SAP system, or network, there can 
be a slight delay between ending the transaction and the PO 
really being saved. If you were to try and display the PO, or do a 
GR, during this delay time SAP would tell you that the PO does 
not exist. 
 
If you find this is happening to you when running your scripts, you 
should enable this sleep time. Set it small initially (e.g. 2 seconds) 
and increase as necessary until you are able to replay the 
recordings reliably. 

NOTE: the sleep settings that you use are saved in the recording 
spreadsheet and will automatically default to the setting you last 
used for that recording.  

5. Click the play button, . 

6. Your chosen SAP session window will be brought to the front and the data 
from your spreadsheet will be used to run your recorded transaction, sit back 
and enjoy the show! 

7. After all the rows in your spreadsheet have been run a pop-up message will 
appear to tell you that the recording has been run. Just click OK. 

8. You're now returned to your spreadsheet. 

 

Checking the Results 
When you made your recording, if you stopped recording immediately after the 
display of a status message then, during the playback, QuickScript will have 
'grabbed' the status message for each transaction and put it at the end of each row 
in the spreadsheet, as below. 
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The ‘Actual’ message id of the status returned by the transaction is also captured 
and compared to the ‘Expected’. In this case, both transactions completed as 
expected and the Actual_Msg is shown in green (it would be red if the actual and 
expected had been different). 

 

 

If any of the rows failed, you can move them to the top of the list, 
add a blank line underneath (to prevent the other rows from being 
re-run) and ‘Run’ again - watching carefully to determine the 
detail of what the problem is (probably a mis-type in the data 
you've entered). 
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Advanced Tools 

The advanced tools are designed to assist in recordings of more than one 
transaction in a sequence. Very often in a sequence of transactions, the input 
required by a transaction is provided by the output of a previous transaction. For 
example, if you wished to test creation of a purchase order followed by goods 
receipt,  to do the GR you would need the PO number resulting from the create 
purchase order transaction. 

QuickScript provides the ‘Data Wizard’ to assist in working with these sorts of 
scripts. It is also worth noting that Excel itself can be very helpful (see ‘Take 
Advantage of Excel’). 

Data Wizard 
After making a recording, the data input (along with status bars and message id’s) is 
sent to Excel and the spreadsheet is displayed. The Data Wizard is an Excel based 
tool, it is not used in the QuickScript recording controls. 
 

 

Remember, QuickScript only records the fields you type into!  
Fields that are left blank, or are defaulted by SAP, will not be 
recorded. 

This is VERY important and crucial to your 
understanding and use of QuicksScript. 

If you wish to record fields defaulted by SAP either 
over-type the data already there or just cut-and-paste 
it back into the same field. 

 
You should use the Data Wizard when you wish to use the output from one 
transaction as an input to another transaction. You can only use the output from a 
transaction if it has been ‘recorded’ in a status bar. 

For example, you have recorded three transactions: 

·  Create Purchase Order (ME21N) 

·  Goods Receipt (MIGO) 

·  Invoice Receipt (MIRO). 
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The Status_Bar output when the PO is saved contains the PO number. You use the 
Data Wizard to indicate that this PO number is to be used as the input to the GR 
transaction when the script is run. This will become clearer as you work-through the 
following example.  

Data Wizard Example 

The screen-shot below shows the columns of the spreadsheet after making the 
recording (these are arranged underneath each other for clarity).  

 

 

 

 

 

Column headings do not always get obvious descriptive texts. 
This is because the text used in the columns headings is 
obtained directly from SAP  and, in SAP, not all of the fields are 
described properly - this is an SAP problem, not a QuickScript 
problem.  

 
Note (as warned above) that not all the column headings are descriptive – you 
should be able to tell what the column is by the data that is in it. In the example 
shown, there is no descriptive indication of what is in column ‘A’. However, if you had 
just made the recording you would instantly recognise that it is the vendor number.  
Similarly, column N is the PO number input to the GR transaction. 

 

 

Change the column header to indicate this, so that you don’t 
forget when you come back to the recording in the future! 

You can change the descriptions in the data columns without 
affecting QuickScript. You must  not  change the descriptions in 
the columns Status_Bar, Actual_Msg and Expected_Msg. 

 

If you are working through this example yourself, it is very likely that your columns 
will be different. This all depends upon your own system configuration and the data 
you input. For example, company code and purchasing organisation are often 
defaulted and you would not need to input them. 

The columns in the spreadsheet are shown again, below, after entering more 
descriptive column headings. 
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We now need a way of specifying that the PO number from the first transaction is to 
be used as input to the second transaction – the Goods Receipt (GR). We also need 
to use the same PO number as input to the MIRO transaction.  

The PO number is in the status message in column K. To use it as the input to the 
GR, we need its value to be automatically transferred to column N and (for use in 
MIRO) to column V.  

Note that the correct value already appears to be in columns N and V – it 
is not!  What you see in these columns is the actual (fixed) value typed in 
when the recording was made.  

To make the value in columns N and V take their value from a previous transaction, 
we need to use the Data Wizard. 

Assigning Inputs Using the Data Wizard 

To use the Data Wizard click  on the Excel toolbar. If the spreadsheet 
contains a recording, the following screen is displayed: 
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The first step is to choose a column in the spreadsheet that you wish to be set from 
the data of a previous transaction. Using the example from before, this would be the 
PO number column for the GR transaction (this is the data in column N). You choose 
this from the drop-down, as below: 

                       

Next, you choose the status message that is to provide  this information. In this 
example, this is the status bar from the PO transaction; you would choose this as 
below: 

 

Finally, you need to choose which of the data items contained in the status message 
is to be used. Note that some status messages can contain several items of data (in 
which case, the ‘drop-down’ will show all of the items in the status message: 

 

We want the PO number (not the document type, which is the first parameter). 
Choose the PO number, as below. 

 

When you have made the selections you can click either the 'Save and Exit' button 
(to save your choices and return to Excel) or ‘Save’ to save your choices and remain 
in the Wizard to enter more data.  As we wish to enter more values, we would just 
click ‘Save’. 

The summary list in the lower half of the screen is now updated to show where 
‘MIGO PO number’ will get its value from (note, this area of the screen may need to 
be scrolled to see the values you are interested in). 

 

 

 

The value that you choose in the wizard is not ‘hard coded’. It is 
not always set to 450009010 – the 450009010 is an example of 
the value that will be used (the example is taken from when the 
script was recorded).  

 
A column that has its data provided by the wizard will have its colour set orange . 
This is to provide visual confirmation in the spreadsheet of which columns will be set 
at run-time by the wizard - the actual values in this column are irrelevant, as they will 
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be populated at runtime by the output of a previous transaction (as you defined in 
the wizard). 

Continuing with this example, we also want the PO number to be input to the MIRO 
transaction. We would set this as below: 

 

Another thing we could do (not a ‘real-life’ example, but useful for testing) would be 
to use the GR document number as in the ‘Reference’ input to MIRO, as below: 

 

The summary list, after making these changes, would appear as follows: 

 

Everything is now ready to run!  

However, there may be a problem if you wanted to use the same script at some time 
in the future. This is because of the invoice date (column S) required by MIRO. To 
solve this problem we would need to either: 

·  enter a new date in the date field in column S prior to the run; 

·  provide the date to column S from an Excel formula. 

The latter is described in section ‘Take Advantage of Excel’. 
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Deleting Assignments Made Using the Data Wizard 

If you were to later change your mind and wanted to ‘delete’ an assignment (e.g. if 
you decided to provide the data directly or by a formula), you need to run the Wizard 
again.  

To stop a column/input field receiving data, you need to select its row in the 
summary list and click: 

 

This button is not  enabled if a row is not selected. Note that, when clicked, the 
change is automatically saved. The spreadsheet column will have its text colour 
changed back to black. 

Take Advantage of Excel 
Remember that you are using Excel as a store for your data. This means that all of 
the Excel functions and formulas are available to you.  
 

 

To preserve any leading zeroes in captured data QuickScript 
always sets the column formats to text. 

Before entering any formula in a cell on the data sheet you must  
first select that column and set its format to General (after 
selecting the column choose Format -> Cells from the Excel 
menu and choose 'General' from the category list). 

 
A common use of an Excel formula would be for obtaining the date.  Referring to the 
create PO, GR, and invoice example, the MIRO transaction requires an invoice date. 
This would be recorded in the normal manner and saved in the data sheet as a text 
value (e.g. 07.01.2006). 

If you wished to use this recording again in the future (e.g. as a re-usable test script) 
then you could replace the text value of the date in the data sheet with an Excel 
formula that returns the current date, i.e. =TEXT(TODAY(),"mm.dd.yyyy") .  

Note the conversion to a text value – this is to ensure that QuickScript takes exactly 
the value you see in the cell. 
 

 

It is important to note that Excel and SAP sometimes use 
different formats. For example, for a date, Excel may show 
07/01/2006 whereas SAP would use 07.01.2006. You must  
make Excel format the data in same way as SAP expects it or the 
run of the script will fail. The best way to ensure the correct 
formatting of the cell is to use the example above, i.e.  
=TEXT(TODAY(),"mm.dd.yyyy") 

Date formats for both Excel and SAP will be dependent upon 
your own system settings and the examples here are for 



 
����������	
���	�� � ���
��
�����

Advanced Tools  ····   29 

illustrative purposes only. 

Status Bar Grab 
With automatic status bar recording enabled  QuickScript 
grabs and records the status bar of all status bars output during the recording. 
Usually, this is at the end of each transaction and for 90%, or more, of recordings 
this is exactly what it is needed and for most users this can always be left set. 

With automatic status bar recording disabled, , status bars 
and associated message ids will not be automatically recorded. They have to be 
‘grabbed’ manually. The QuickScript recording controls show another button: 

  

Note that this button only becomes active when you have started recording. When 
clicked, any status bar currently showing on the session being recorded will be 
'grabbed'. That is, it will be put in the script and shown on the data sheet in the same 
way it would if recorded automatically. 

This is useful of you want to limit the number of status bars recorded - for instance if 
you are recording a very long script and want to minimise the number of columns  in 
the spreadsheet (remember, each status bar results in 3 columns adding to the 
spreadsheet).  

Obviously, in order to compare actual against expected, or to use the outputs of a 
transaction as inputs to other transactions, the status bar is needed. 
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Installation Guide 

QuickScript is based on SAP’s Scripting API. This API has only been available since 
SAP GUI 6.2 and is disabled by default.  Note that it is the version of SAP GUI that is 
important, not the version of SAP. 

Establishing a suitable environment requires the following:  

·  ensuring a suitable version of SAP GUI is installed; 

·  ensuring SAP GUI Scripting is installed; 

·  ensuring scripting is enabled on the server(s); 

·  ensuring scripting is enabled on the clients; 

·  ensuring your client is configured to use the Dialog display mode for Help; 

·  ensuring your client is not set to use a Low speed connection.  
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Checking SAP GUI Version 
To check the version of your SAP Windows client:  

Open the SAP Logon dialog box and click the button on the left side of window’s  title 
bar, as below. Choose ‘About SAP Logon’ 
 

 

The ‘SAP Version Information’ is shown. Confirm that the version is at least 620. If it 
is 620 (not above) then also confirm that the Patch Level is at least 36. 
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Installing SAP GUI Scripting  
 

SAP GUI Scripting needs to be installed at the same time as SAP GUI, and this is 
usually the case for most installations. It is unlikely that you will need to do this but if 
you are experiencing difficulties (if QuickScript can not detect open sessions, for 
example) then re-installing SAP GUI and confirming this setting is suggested as a 
likely cure. 

During SAP GUI installation you must select the SAP GUI Scripting installation 
option, as below. 
 
 

 
 

Correct installation of SAP GUI and SAP GUI Scripting is a pre-requisite for all the 
other installation activities described. 

 



 
����������	
���	�� � ���
��
�����

Installation Guide  ····   33 

Enabling Scripting on the SAP Application Server 
By default, scripting is disabled, so it is very likely that you will need to perform this 
activity. 

To enable scripting, you need to set the profile for sapgui/user_scripting to TRUE on 
the application server.  

To change the value of this profile parameter, follow the steps below. 

 

1. Run transaction RZ11.  

2. Enter parameter name sapgui/user_scripting, as below.  
 

 
 

3. Click the Display button . 
 
Note: If the message ‘Parameter name is unknown’ is displayed in the status 
bar, then you do not have the required support package level installed. 
Check OSS for updates. 
 

4. The profile value must be set to TRUE, as below. 
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5. If the profile value is not set to TRUE, then it must be changed. Click the ‘
Change value’ button in the toolbar.  

6. Enter TRUE in the ProfileVal box and click the Save button. You must enter 
TRUE in capital letters – lower or mixed case will not  work. 
 

 
 
Note also the ‘Switch on all servers’ check-box. To enable scripting for all 
users, this parameter must be set on all application servers so this must be 
selected. If you wish to enable scripting only for a specific group of users, 
then only set the parameter on application servers with the appropriate 
access restrictions. 

7. After saving the changes, the value is displayed as TRUE. However, this 
change takes effect only when you log in to the system, therefore, you must 
log out and log on again.   
 
Note: If the settings do not seem to be taking effect, you may not have the 
required support package level installed. Check OSS for updates. 
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Enabling Scripting on the SAP Application Client  
 

To enable scripting on SAP GUI: 

1. Log on to an SAP server; 

2. Click the Customizing of local layout  SAP toolbar button and then choose 
Options.  

3. Click the Scripting tab. 
 

  
 

4. Confirm that the Enable Scripting check box is selected. If not, select it.  
 

5. Clear both the ‘Notify when a script attaches to a running GUI’ and ‘Notify 
when a script opens a connection’ check boxes. 
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Setting F4 Help to Use Dialog Display Mode  
This is an optional setting and only needs to be made if you intend to include the 
recording of F4 help in your recordings. Most users do not do this. 

When the SAP GUI uses the SAP Scripting API, it cannot load the F4 Help screens 
in Control mode. Therefore, you should ensure that your client is set to load F4 Help 
screens in Dialog mode. 

To do this:  

1. Log on to an SAP server 

2. Choose Help > Settings from the SAP menu bar.   

3. Click the ‘F4 Help’ tab. 
 

  

4. If the ‘System defaults’ section for ‘Display’ (on the right, above), indicate 
‘Dialog’ then you can choose ‘System defaults’ on the left, user-specific, 
setting. If not, you must choose ‘Dialog (modal)’ for the user specific setting – 
as shown above. 

5. Click  to save your settings. 
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Setting F1 Help to Use Modal Dialog Box Mode  
 

As with F4 Help, F1 Help can also be set to Modal  - as with F4 help this is optional 
and only needs to be done if you intend to include recording of help key presses in 
your scripts.  

To do this:  

1. Log on to an SAP server 

2. Choose Help > Settings from the SAP menu bar and Click the ‘F1 Help’ tab. 
 

 
 

3. Select ‘in modal dialog box (R/3).  

4. Click  to save your settings. 
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Checking the Connection Speed 
 

If you use the Low speed connection option, SAP does not send enough information 
to QuickScript for it properly record and run scripts. You must check that this option 
is not selected. 

To do this: 

1. Open SAP Logon and select a server 

2. Click the ‘Properties’ button.  

3. Click the Advanced button. The Advanced Options dialog box opens. 

4. In the Connection speed section, confirm that the Low speed connection 
check box is cleared, as below: 
 

 

 

 

 

 


